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Preface

Lutheran Service Builder had an inauspicious beginning. It was con-
ceived by a think tank of three, sipping espressos at Starbucks. We were discussing
Dr. Kent Burreson’s Worship class and our assignment to plan services for varied
settings. And we were dreaming of two things: access to a culturally-broad collection
of hymns and the ability to drag-and-drop them into services.

In the spring of 2004 I began work on a very simple database. Later that year,
Dr. Burreson and Dr. Paul Grime of the Commission on Worship showed my work
to Concordia Publishing House. My project and CPH’s needs were perfectly paired.
CPH acquired the project in December and ensured that the Builder would not be
stillborn.

The last two and half years of work on Lutheran Service Builder have been
exhilarating. This software has been torn to pieces and reassembled countless
times—a fact that thrills me. I can say with authority that no criticism or suggestion
has been ignored. Thanks to the sharp minds of many men and women, Lutheran
Service Builder far surpasses what would have been my best work.

Version 1.0 is finished. It is loaded with the exceptional new hymnal, Lutheran
Service Book. This manual is in your hands and the blue icon may already be on
your desktop. Meanwhile, my desktop is littered with notebooks of unimplemented
bells and whistles. The Builder will always be a work-in-progress. I will miss working
on it; but I think the foundation has been laid. If this software proves useful to you
and if its resources continue to grow, my coffee shop dream will become a CPH
reality.

Jesus broke five loaves and fed five thousand. May He take and break this loaf
too.

Robert Lail, May 2006
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Chapter 1. Introduction

Welcome to Lutheran Service Builder! Thank you for purchasing what will
become your indispensable companion for creating meaningful and Christ-centered
services for your congregation using the liturgy, propers, lectionary, and hymns of
Lutheran Service Book. We at Concordia Publishing House are very excited about
this product and are pleased to bring it to you in an easy-to-use, intuitive package.
Lutheran Service Builder has been conceived, designed, constructed, and field-test-
ed as an essential part of the constellation of resources that make up the Lutheran
Service Book and its companion editions.

This manual serves as your introduction to the power, ease-of-use, and utility of
Lutheran Service Builder. Here, you’ll learn how to use it to plan, outline, generate, and
fill worship service bulletins to fit and serve your congregation in their worship life.
Lutheran Service Builder will save you time and effort in your service preparation; 
it will fill in information for you automatically, help you find related materials of all
kinds, allow you to define and input your own custom worship resources, and then
tie all those things together into a cohesive, readable, and printable service bulletin,
ready for use by your congregation.

Lutheran Service Builder includes multiple paths of customization and options to
give you control over your services. As a result, using Lutheran Service Builder is as
simple or as powerful as you would like it to be. As you will see in the included tutor-
ial, creating a simple service and filling it with content is easy to do and will not take
you long to learn or do. On the other hand, if you would like to custom-create your
own services, alter the flow of an included service, create and insert your own hymns,
prayers, or liturgical elements, or change what printed bulletins look like, you will be
able to do so. It will take a little more time and some investment on your part to learn
how to use Lutheran Service Builder in that way, but the more time you spend with it
and the more you use it, the more powerful the software will become.

To get started, begin with the section in this book on how to install the program.
Go through the steps provided, and finish the installation of Lutheran Service
Builder on your computer. Once you’ve done that, we suggest you keep going, 
following our directions on setting up the program with your preferred options 
and settings. You can follow our instructions directly, or you can input your own
information while you follow along; it’s your choice. After you complete the initial
setup, we’ll then walk you through the completion of a sample service for worship.

The rest of this manual is arranged by topic and will give you specific informa-
tion about various portions of the program. It will also outline the various options
and settings available at each step of the service preparation process. If you get
stuck, or need more information, check in the back of this book for more resources
you can use to help you out. Remember that you can always find the latest update
of this manual at lsb.cph.org. An electronic copy of this manual is also included in
PDF format on the Lutheran Service Builder installation CD-ROM.

Now, let’s get to installing and learning about Lutheran Service Builder.
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Features
Lutheran Service Builder was designed with both church professionals and 

volunteers in mind, and it incorporates many features that serve as digital versions
of tasks you likely have already been doing as part of your service preparation.

Lutheran Service Builder includes the ability to:

• create and maintain complete services for any day of the year;

• search and filter results based on day, suggested materials, Scripture reference,
or subject material;

• edit services and the flow of a service using an intuitive editing view;

• introduce custom materials using helpful tools and utilities;

• choose between textual and musical settings of services and hymns, and place
them in a service automatically;

• customize the look and feel of your services with user-definable styles;

• export your services for printing or projection in a multitude of formats (included
in the Congregational Edition and dependent on an annual subscription);

• report your usage of copyrighted materials over the Internet automatically
(included in the optional LSBHymnLicense.NET subscription);

• much more, including some features yet to come!

Included Materials
Included in the product packaging, you should have the following:

• User’s Manual

• Lutheran Service Builder installation CD-ROM

• Installation Guide
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System Requirements
In order to install and use Lutheran Service Builder, your computer must have

at least the following specifications:

• Microsoft® Windows® 2000 or later

• Microsoft Internet Explorer 5.0 or later installed (not included with Lutheran
Service Builder installation)

• Microsoft .NET Framework 2.0 or later installed (included with Lutheran
Service Builder installation)

• 512 MB RAM

• 150 MB free hard disk space

• A CD-ROM drive

Recommended System Specifications
For the best possible experience with Lutheran Service Builder, we recom-

mend that your computer have at least the following specifications:

• Microsoft Windows XP Service Pack 2 or later

• 1 GB RAM or greater

• 250 MB free hard disk space or greater, depending on custom service elements

• A broadband Internet connection
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Chapter 2. Getting Started

Let’s take a moment to get you up and running with Lutheran Service Builder.
We’ll get you used to how it works, what it looks like, and what you can expect
from it. For now, you won’t be learning how to use some of the more powerful
aspects of the program, but by the end of our brief tutorial, you should be able to
create a complete Sunday service using Divine Service, Setting Three, a standard
set of readings, and most of the default options. What you’ll end up with will be
similar to what you would be using on a Sunday morning if you were to simply use
hymn numbers and the liturgy forms provided in the Lutheran Service Book Pew
Edition. You’ll be able to print a proof of your test service and get a feel for what
the services generated by Lutheran Service Builder will look like, and better under-
stand how you would like to use them in your unique congregational setting.

Most of the choices you will have to make to get Lutheran Service Builder to
work for you will take place over the next few pages. Please go through this process
carefully and accurately, to ensure that you have the best experience possible. You
will be able to change all the choices you make when you run the program for the
first time, but it will be far easier for you in the long run if you complete everything
accurately in the first pass.

Installing Lutheran Service Builder
Lutheran Service Builder has been professionally developed, constructed, and

packaged to work with your computer like any other application you regularly use.
You will find that installing Lutheran Service Builder will feel very familiar and
comfortable, and the process will be smooth, quick, and effortless. To install
Lutheran Service Builder, please perform the following:

1. Remove the CD-ROM from the packaging, and insert it into your computer’s
CD-ROM drive.

2. The installation program should run automatically. 
If it does not, go to Start ➞➞ My Computer, or 
double-click the My Computer icon on your desktop.
Double-click the icon for your CD-ROM drive 
(usually D:), and then double-click on the icon titled
Install Lutheran Service Builder.

3. The Installer will check to ensure you have the latest
versions of the Windows Installer and the .NET
Framework. Both are required for Lutheran Service
Builder to run. If your computer requires an update
to either, those components will be installed auto-
matically before proceeding with the installation of
Lutheran Service Builder.

Figure 2.1. 
The Lutheran Service Builder
Installer icon.
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4. The Installer will load and present an introductory screen. Click Next to begin.

Figure 2.2. The Lutheran Service Builder installation introductory screen.

5. The End-User License Agreement (EULA) will be presented for you. The
EULA outlines the rights granted to you as a user of Lutheran Service Builder.
Read the terms, or if you prefer, use the Print button in the lower-right to send 
a copy of the EULA to your printer. When you have read the Agreement and
accepted its terms, select the appropriate response and then click Next.

Figure 2.3. The End-User License Agreement.
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6. The Installer will ask you where you would like to install Lutheran Service Builder.
The default location is C:\Program Files\Concordia Publishing House\
Lutheran Service Builder\. If you would prefer to install the program in a
different location on your computer, click the Browse... button and you will be given
an option to select an alternate location. When you are ready to install, click Next.

Figure 2.4. Choosing an installation location.

7. Next, you will be asked if one person or multiple people will be accessing the
information used in Lutheran Service Builder. If you are only installing on a
single computer, select the option I am the only one who will be using the
databases.

If you plan on installing Lutheran Service Builder on more than one computer
and this is the first installation of Lutheran Service Builder you are performing,
you should select the option for I need to install new databases for more than
one user. You will then need to use the Browse… button below to select an
installation location for the databases.  This location should be network-accessible.
If you are installing a second, third, or later copy of Lutheran Service Builder,
and already have the databases installed in a networked location, select the
option I need to use existing networked databases. You will need to use the
Browse… button below to tell the installer where your networked databases are
installed.  Select the appropriate folder and click the OK button.

Figure 2.5.
Choosing
between a 
single-user
installation and
a multi-user
installation.
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8. Then, you will be prompted to enter your customer information. It is important

that you enter this information accurately. Please input the name of the primary

user of the computer on which you are installing the program, and the name of 

your organization. You will also need to input your CPH Customer Number, 

which should be included on your order invoice. Click Next when you are done.

You cannot continue until you have completed this step.

Figure 2.6. Entering customer information.

9. You will be given one final confirmation dialogue before the Installer will set up
Lutheran Service Builder on your computer. When you are ready, click the
Install button. You’ll see a progress bar and some messages indicating to you
the status of your installation. When it’s complete, you’ll receive a confirmation
message. If you would like one, click on the checkbox labeled Create a short-
cut to Lutheran Service Builder on my desktop. Click the Finish button to
complete the installation process.

Figure 2.7. The final step in the Lutheran Service Builder installation process.

10. You’re done with installation! Now, it’s time to customize Lutheran Service
Builder for your unique needs.



Using Lutheran Service Builder
for the First Time

The first time you run Lutheran Service Builder, the
Setup Wizard will appear to assist you in tailoring the soft-
ware for use in your church. The program will walk you
through the following steps, which will set default options 
for your first Location. You may start Lutheran Service
Builder in two ways. Either double-click on the shortcut 
icon placed on your desktop, or use your mouse to navigate
to Start ➞ Programs ➞ Concordia Publishing House ➞
Lutheran Service Builder. 

Figure 2.9. Navigating to Lutheran Service Builder using the Start menu.
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Figure 2.8. 
The Lutheran Service
Builder shortcut icon.
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1. Lutheran Service Builder will need to know some information about the
Locations for which you will typically be planning services. Click the Add button
to create a new Location. Then, type the name of the new Location and press the
Enter key. You must supply at least one Location.

As you can see, we’ve named our first location Sanctuary.

Figure 2.10. Entering the first Location.

2. When you have done this, you will then need to answer a few questions about
your Location. First, Lutheran Service Builder needs to know which Lectionary
to use when you plan services at the selected Location. Lutheran Service Builder
provides access to either the Three-Year or the One-Year Lectionary. If you
have entered more than one Location in Step 1, you must select each Location
and choose a Lectionary for each.

In our example, we’ll select the Three-Year Lectionary.

Figure 2.11. Selecting a default Lectionary.
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3. Lutheran Service Builder also needs to know approximately how many 
worshipers will attend services at the selected Location in an average week. 
This information is necessary for the software to assist you in acquiring 
permission to reproduce copyrighted materials. It is extremely important 
that you be accurate with this setting; this number must reflect your actual
average church attendance.

For purposes of this example, Sanctuary regularly has under 100 attendees in an
average week.

Figure 2.12. Selecting an attendance range.

4. When you have selected a Lectionary and an attendance range for each Location,
click the Next button.

The second screen of the Setup Wizard asks you to assign standard settings to
your Locations. It is important during these steps to give the information that
most often applies to the Locations you entered in the previous steps. You may
easily change or alter this information in the future to suit services different from
your regular schedule.

Choose the Location you want to configure from the drop-down box at the top of
the screen. If you have only one Location entered into Lutheran Service Builder,
it will be selected for you automatically. You see here that the system has already
selected Sanctuary.

Figure 2.13. With only one Location to choose from, Lutheran Service Builder chooses
automatically.
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5. Now, you’ll need to add at least one service time for your selected Location.
Since you don’t have any service times already entered, click the Add button.

Choose a day for your service from the drop-down menu that appears. Most services
will be on Sundays. However, Lutheran Service Builder can easily accommodate
services held on other days. Select a time for your regular service. In our example,
we’ll set our first service for 8:00 a.m. on Sunday mornings.

Click the OK button to add the service to your list.

Figure 2.14. Adding a service time to a Location.

6. You can now also select a default liturgy for your service. If you would like to do
so, click the drop-down menu to the right, and select the order of service you
would regularly use. You don’t have to select a default order; if that’s the case,
leave None selected. We’ll use Divine Service, Setting Three for our tutorial
later in this manual, so that’s what we’ll select now.

When you have checked to make sure the service time you’ve entered is accurate,
click the Next button to continue with the Setup Wizard.

Figure 2.15. Selecting a default liturgy.
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7. The final step in the Setup Wizard is to decide what type of content printing you
would prefer by default. Select a location from the drop-down menu, or leave
the selection at the default, which is All Locations. If you have only one
Location, it will be selected for you automatically.

For both hymns and liturgical elements, please choose if you would like to print
a title and page number (for use with Lutheran Service Book Pew Edition), the
title and text of the element (for those who will be speaking liturgical elements
or for those hymns with familiar tunes), or the title, text, and music of the elements
(for responsive singing of liturgical elements or for hymns with less familiar
tunes or congregations who prefer printed music).

We’re going to set both liturgy and hymns to print with music.

When you have made these selections, click the Finish button.

Figure 2.16. Selecting default element printing.

8. You will now be prompted to activate your copy of Lutheran Service Builder.
The Setup Wizard will present you with a list of activation choices.  The first
three choices only apply to you if you have purchased the Congregational
Edition of Lutheran Service Builder.

To activate your product immediately using your Internet connection, select 
the option I have the Congregational Edition and would like to activate
using the Internet.  Lutheran Service Builder will immediately attempt to use
your Internet connection to retrieve your licensing and activation information.
The Wizard will display a confirmation dialog upon success.
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If you have installed Lutheran Service Builder on a computer that does not have
access to the Internet, and would like to activate it, select the option I have 
the Congregational Edition and would like to activate using the phone.
The Setup Wizard will display the phone number for Lutheran Service Builder
Customer Support, and display your CPH Customer Number.  A support techni-
cian will ask you for this number, and then relay your license numbers and
installation keys over the telephone.  Enter those keys in the blanks provided 
and click OK. You will be presented with a confirmation dialogue once
Lutheran Service Builder has verified the codes.

If you do not wish to activate your copy of Lutheran Service Builder at the time
of installation, select I have the Congregational Edition and will activate
later. Lutheran Service Builder will launch immediately.  Keep in mind that
you will not be permitted to export any information or service you create until
you have activated your product and your licenses have been verified.

If you have instead purchased the Home Edition of Lutheran Service Builder,
indicate this by marking the option I have the Home Edition in the activation
dialogue.  You will no longer be requested to activate your copy of Lutheran
Service Builder.

Figure 2.16. Selecting default element printing.

9. That’s it! You’re ready to start using Lutheran Service Builder!
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Getting to Know 
Lutheran Service Builder

Now that you’ve set up Lutheran Service Builder for a basic Location, let’s
take a small tour of the different parts of Lutheran Service Builder. We will see 
the types of information you will regularly find there and how to interact with the
program. Once you have read and understand this section, continue on to section 4,
where you will plan and create a simple service, ready to be printed and used at
your church.

Figure 2.17. The various parts of the Lutheran Service Builder interface.



The Menu Bar

Figure 2.18. The Menu Bar.

This area of Lutheran Service Builder acts just like the menu bars in all your
other applications, and uses familiar terms and labels to help you in your tasks. 
The Menu Bar is split into different named menus, each with a specific purpose 
and list of commands.

The File Menu

The File menu holds options and com-
mands used for dealing with the basic oper-
ation of the program and with the service
you will be creating.

New Service... brings up the Calendar
view and allows you to create a new service
altogether.

The Import… and Export options allow you to manage some of the data used
by Lutheran Service Builder. Importing allows you to bring information from a file
produced by another installation of Lutheran Service Builder into your copy for
later revision or use in another service.  Selecting this option will present you with
a file browser.  Select the data you would like to import and click Open.

You may export two types of resources: services you have created, and custom
worship resources you have generated with the My Worship Resources tools
included with Lutheran Service Builder. To export a service, select it in the
Calendar view and then use the Service… part of the Export command.  Select a
location to which you would like to save your exported service, and click the Save
button.  You do not need to export a service to save your progress in creating it.
Lutheran Service Builder saves your services automatically as you work. To
save a custom worship resource, choose the Data… option.  You will be presented
with a dialogue listing your custom resources.  Select the resource you would like
to export and click OK.  Choose a save location for the resulting file, and click
Save.

The last option will Exit the program and save your service and content infor-
mation automatically.

Figure 2.19. The File menu.
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The Edit Menu

The Edit menu commands function just as they do in
your word processor or similar programs. Every command in
the Edit menu has something to do with editing or moving
text or objects within a service.

Undo and Redo allow you to reverse changes you have
made.

Cut, Copy, and Paste move text and/or images to and
from the clipboard, just like any other application for
Windows.

Clear will delete a section you have selected, while
Select All will highlight all elements or text in your current
window.

These commands are all context-sensitive. They will per-
form different functions depending on what you are doing and what resources you
are editing. In some cases, these commands may not be available at all, in which
case they will be “grayed out.”

The Tools Menu

The Tools menu allows you to move
around from place to place in Lutheran
Service Builder with ease, using one-click
access to many of the features and functions
of the program.  It also contains commands
that allow you to perform maintenance 
functions on your Lutheran Service Builder
installation and to change your personal 
preferences settings.

The first option begins the activation
process for Lutheran Service Builder. You
should only use this command if you have not
activated your product during the Setup
Wizard, if you have moved your installation
to a new computer, or if you are renewing a
previously lapsed subscription.

The next grouping of options allows you to access the search features of
Lutheran Service Builder directly.  They provide easy access to finding a particular
hymn, pericope, Scripture reference, or proper from the entire Lutheran Service
Builder database.

Selecting Edit My Worship Resources allows you to create, edit, and store
custom service elements and service outlines, bringing your own personal touches
to Lutheran Service Builder.

Figure 2.21. The Tools menu.

Figure 2.20. 
The Edit menu.
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Three options are also provided for updating and maintaining your Lutheran
Service Builder installation.  Your subscription information to both the Congregational
Edition and LSBHymnLicense.NET will be updated on an annual basis, to reflect
new expiration dates.  Click these options to run the updaters when you are alerted
to the fact that your subscription has lapsed.  Check for Updates… will run the
Lutheran Service Builder auto-patch utility.  If any program or data updates are
available, you will be prompted to download them to your computer.  An active
Internet connection is required to download these updates.

Backup databases… and Restore databases… allow you to store extra copies
of the files Lutheran Service Builder uses to present you with materials.

The Preferences… option will bring up the Preferences window, where you
can change the information and many of the settings Lutheran Service Builder uses
to customize your experience to the needs of your congregation.  This is where you
will go if you would like to change any of the settings you created when you first
ran Lutheran Service Builder and completed the Setup Wizard.  More information
on this command is available in Appendix A: User Preferences.

The Help Menu

This is, unsurprisingly, where you will go if you
need help with a feature of Lutheran Service Builder.
The Help link will take you to the Builder’s integrat-
ed help features, which contain a full copy of every-
thing covered in this manual including updates after
this manual was printed.

The lsb.cph.org option will open the Lutheran
Service Book Web site in your default Web browser.
There, you can find more information about getting
help with your program, obtaining support, or adding
support or licensing subscriptions to your Lutheran
Service Builder account. The View online manual
option will open up the latest version of this manual 
in your Web browser, as well.

The About option will show you information on Lutheran Service Builder—
who created it, what version you currently have, and give you some basic information
on your installation. Support technicians may ask you to view this information from
time to time.

Figure 2.22. 
The Help menu.
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The Project Bar

Figure 2.23. The Project Bar.

The Project Bar shows you the status of your current project. Icons, arranged
in a row, show you where you are in the process of creating your service or editing
your materials. Each icon represents a step in the process of your current Project.

To the left and right of the Project Bar are arrow buttons. Clicking either one 
of these arrows, to the left or to the right, will move you one step back or one step
forward, respectively, in the creation process. If you are unable to move forward,
check to see if you have any other required tasks to perform before continuing your
project. The system will remind you with a warning if you have additional work
that must be performed before moving on.

To the far right of your screen is a text label that displays a description of your
current step.

The Task Pane and The Work Pane
The main area of the Lutheran Service Builder window is where you will per-

form the majority of your work and see the results of your service construction and
customization.

It is split into two panes: the Task Pane, on the left, and the Work Pane, on
the right. In general, the changes you are going to make to the service and the actu-
al building of the service will take place in the Work Pane. Information and tools
Lutheran Service Builder needs to give you—usually information from the previous
step—will be listed in the Task Pane.

These panes support most of the tasks with which you are familiar—you can
drag-and-drop elements from one area to another to build your services. You will
be presented with calendars, planning tools, page layouts, and previews of the 
elements you have selected to include in a service. Selections are handled through
single- and double-clicks, and everything is presented to you automatically as you
build services.



Planning a Simple Service — 
A Tutorial

You’ve set up Lutheran Service Builder for a Location, and now you’ve come
to know the basic parts of the interface and how they work. Now, it’s time to take
that knowledge and build on it.

We’re going to use Lutheran Service Builder to create a sample service, fill
that service with content, and then print out that service for use. Through this
process, you’ll gain familiarity with how Lutheran Service Builder works, how to
add hymns, and how to get that service to print.

Let’s begin.

At the main menu, Lutheran Service Builder will ask you, What would you
like to do? Click on the blueprint icon, next to Create/Edit a Service.

Figure 2.24. The selection icon for Create/Edit a Service.

Choosing a date and place for a new service
First, you will need to tell Lutheran Service Builder which Location you will

be using when you create the service. In the Task Pane, a drop-down menu will
appear with a list of your locations. Select your
desired Location—likely the Location you
entered into the Setup Wizard when you installed
Lutheran Service Builder. If you only have one
Location, it will automatically be selected.

Now that we’ve selected a Location, we need
to set a date and time for the service. On the left-
hand side of the Work Pane is the Calendar. The
Calendar will automatically display the current
month. Select an upcoming Sunday by clicking on
the date in the Calendar. Click the New Service
button to the right of the Calendar.

Figure 2.25. 
Selecting your Location. The
month selection is underneath.
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A service will be created with the default options for that Sunday. More
detailed information will be presented in the Service Settings box below, but for
this example we’ll just use the standard options for that Sunday. The festival and/or
Sunday information will automatically be filled in and a matching title assigned to
the service.

Figure 2.26. Selecting a date and creating a service in the Calendar.

Click the green arrow in the Project Bar to move on to Step 3.
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Choosing and customizing an order of service
You’ll move on now to selecting an order

of service for the service you just created.
This is where you will set the basic building
blocks for your service. In the Task Pane, a
list of the available orders will be presented.
Under Lutheran Service Book, select Divine
Service, Setting Three from the list of Divine
Services.

The basic order of worship will appear 
in the Work Pane, complete with default 
elements. You’ve just created a basic service!
Congratulations!

However, let’s say we want to change
things a little. Say, for instance, we expect 
the Lord’s Supper to need three Distribution
Hymns. This is very easy to do, and won’t
take any time at all.

Click on the link in the Task Pane labeled
Add service elements. From there, find the
service element labeled Hymn.

Now, using your
mouse, click and hold on
the “Hymn” element, and
drag it over to the Work
Pane; you’ll get a little
“ghost” of the word
“Hymn” while you move it.
A small triangle will appear
in the order of service to
indicate to you where the
hymn will be placed into 
the service. Drop it into the
service next to the other 
two distribution hymns by
releasing the mouse button.
“New Hymn” should appear
in your order of service.
That’s all there is to it!

Click the green arrow at
the right of the Project Bar to
move on to Step 4.

Figure 2.28. 
Finding a hymn service
element to add to an
outline.

Figure 2.29. 
Dragging a hymn element
into a service outline.

Figure 2.27. 
Selecting an order of service from
Lutheran Service Book.
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Choosing and modifying the content of the service
Now, let’s take a look at how to fill your 

service with content. The service outline has now
moved to the left, onto the Task Pane. Added
hymns and additional readings will remain blank
until you have selected specific content for them.
If you take a look at the service outline, you’ll see
what I mean.

A check box will appear next to any service
elements where you can change or modify that
element by either selecting from options or by fill-
ing it with additional material. Select the Hymn of
the Day in your order of service. It doesn’t current-
ly have any content, which means it will display
nothing when you finish editing the service. We
don’t want that, so click on the hymn.

And now we need to select a hymn to fill that spot. The Work Pane will first
offer suggested hymns for the Sunday or festival you have selected for your current
service. Select one of those suggested hymns and double-click it. Lutheran Service
Builder will now show you what it has done—you’ve got a complete hymn with
text and music, automatically inserted into your service!

Figure 2.31. A fully-selected hymn element.

There’s a lot more you can do with this function, but for the moment, we’ll
move on, and explore those features in-depth in Chapter 3.

Figure 2.30. 
Empty distribution hymn elements.
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Go to each hymn listed in the order of service, and select
a different hymn for each one. In this way, we’ll provide
thematically appropriate hymns for the entire service. It’s
pretty simple to do.

Click the green arrow in the Project Bar to move on to
Step 5.

Obtaining copyright permissions for the service elements
Before you export any portions of your service and prepare them for congrega-

tional use, you are required by law to obtain permission to use any copyrighted
materials. Prior to completing this step in the tutorial, please consult with your
music director or pastor about your congregation’s existing copyright licenses and
how they are administered. Have the types of licenses you hold and their identifi-
cation numbers handy for this section of the tutorial. If you have subscribed to
LSBHymnLicense.NET, and entered that information earlier in the tutorial, this step
will be largely automated.

Figure 2.33. The Copyright Permissions step asks for information about a sample hymn.

To the left, you will see the outline of the service you have created. Bolded
items indicate copyright permissions that must be detailed to complete the export
process. Click on a bolded item to select it and bring up the list of permissions
required in the Work Pane.

Many hymns have one or more permissions required for legal reproduction in
service folders or PowerPoint presentations. Hymns covered by LSBHymnLicense.NET,
offered in conjunction with Lutheran Service Builder, will be automatically handled
and will not be displayed. For those hymns that have copyrights not covered by the

Figure 2.32. 
An order of service 

with all hymns finished.
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agreement or are not in the public domain, the Work Pane will list each component
of the selected hymn and its respective copyright holders.

If you have a copyright license other than LSBHymnLicense.NET, you may
select the This resource is covered under the following license option. Then,
enter the name of the license you hold (e.g., OneLicense.net, CCLI) and the license
number assigned to your congregation. An attribution notice will be added automat-
ically after each hymn using the information you provide.

Each copyright holder’s contact information will also appear to the right of 
the item requiring permission. You may need to contact each holder individually 
to obtain permission to use their resources. If you do, select the I have obtained
permission to use this resource independently option. You will need to use your
word processor to insert the credit line and any other information required by the
copyright holder after you have exported the service.

Once you have detailed the permissions for each required component, the
hymn will no longer display in bold in the service outline. Complete this process
for each hymn. When you have finished the process for all licensed materials in
your service, you will be able to continue.

Click the green arrow in the Project Bar to move on to Step 6.

Printing a bulletin proof from the service outline

Note: The following instructions assume you are using the Congregational
Edition of Lutheran Service Builder. If you are using the Home Edition,
you will not be able to continue to print the service you have just created.
For more information, please read the section in Chapter 3 entitled, “What
Do I Need to Export My Services?”

You’re at the final step; you’ve created a service, filled it with content, and
made sure you’re using those materials legally. Now, we’ll see how simple it is to
print out a proof copy of that service. Click on Create a bulletin for the service.
You’ll be presented with a preview of your service. From here, you would normally
export that service and then edit it further using your word processing program of
choice. For now, let’s print out a proof copy so we can get a general idea of what
your service will look like.

Click the Print Proof button at the
bottom of the Task Pane. It’s the one that
looks like a little ink jet printer.

That’s it! You’ve successfully created,
customized, and printed a service proof in
only a few easy steps!

Figure 2.34. 
The Print Proof button icon.
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If you would like to use the content you just created in a service bulletin, use
the export buttons provided at the bottom of the Task Pane.  There is a separate but-
ton for each type of file Lutheran Service Builder can create.  Upon clicking the
button appropriate to the type of file you would like to export, you will be present-
ed with a save dialogue.  Select a save location for the file you wish to create and
click the Save button.

In the tutorial, we walked you through the process of creating and editing a ser-
vice, eased you into the process, and gave you some familiarity with how Lutheran
Service Builder works and how to use the program. In the next chapter, we’ll go in-
depth with these processes, and show you more of the powerful features and cus-
tomization available in Lutheran Service Builder.

If what we covered in the tutorial is enough for you to get started and begin
creating services for use in your church, then feel free to stop reading and begin
using Lutheran Service Builder on a weekly basis! If you’d like to learn more, con-
tinue reading.
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Chapter 3. Creating and Editing
Services

Now that you’ve received a basic introduction on how to use Lutheran Service
Builder and have a general idea of what you are going to experience as you build
services and edit them to suit your needs, it’s time to give you some information 
on the more powerful features of the program. At this point, you should use the 
program frequently, so you can become more familiar with how it works and what
options are available to you. This chapter will cover the various aspects and steps 
of service building in-depth.

To aid you in learning these features, it’s a good idea to have the Builder open
while you read this chapter. This way you can practice using these features as you
read, and you won’t be surprised when you see how something works in action.
Screen shots are helpful, but they don’t replace actual experience working with the
program.

We’ll spend a little time with each step in the process. We’ll outline everything
you can do with Lutheran Service Builder, how to go about doing it, what it will
look like, and the options available to you in the process.

Choosing a Date and Place

Figure 3.1. The Calendar step in service creation.

When you first click on Create/Edit a Service, you are presented with the
Calendar. This is the most basic way you will be creating services, and many of the
choices you make here will affect later steps in the process of completing a service
and filling it with content.

In the Task Pane, you will be presented with two simple controls. The first is to
select a Location for which you will be planning this service.
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We went through Locations very briefly in the initial setup of the Builder and
also in the tutorial. If you followed those directions, you should only have one
Location in this box. If you would like, you can create more than one Location and
store Services for both in Lutheran Service Builder. To do so, click the Location
drop-down menu, and then select Add/Edit Locations.... This will open up the
Locations tab of the Preferences dialogue.

Here, you can create, modify, or delete your current saved Locations. To add a
location, simply click the Add button, then type in the name of your location and
press Enter. You may then use the controls located below to select a Lectionary and
number of average attendees.

Why would I want to use more than one Location?

There are some situations where using multiple locations would be
extremely helpful in planning, storing, and recalling services for use. 
For example, if you were planning services for a dual-parish or other split
ministry situation, such as satellite worship locations, using more than one
Location would help to keep the services for those locations separated—
making them easier to find and edit later. You could also use more than
one Location if your services normally use vastly different orders of ser-
vice on the same day.

Once you have selected a Location, then select a month from the next box in
the Task Pane. As you change this selection, the Calendar displayed in the Work
Pane will change respectively. Once you have selected a month in which you will
be holding the service, it’s time to pick a date and define the basic characteristics 
of that service.

Hovering over a date on the Calendar will highlight that date and display pertinent
information associated with that date at the top of the Task Pane. Colors located on
the corner of a given Calendar day indicate a liturgical color for a given seasonal
Sunday, a dated feast, or festival.

Clicking on a day fills that day with a gray marker. Clicking on the New
Service button to the right creates a service, which then is displayed as a combina-
tion of date and occasion in the box to the right of the Calendar. That service will
also be highlighted in blue, indicating that you are editing that particular service.
For a given month, if you would like to edit an existing service, simply go to the
month of your choice, then click on the service title in the far right of the Work
Pane.

When you have selected a service, additional options for that service will be
displayed under the Calendar. There are three controls here for defining the particu-
lars of the service you have just selected.

The first, in the upper left, allows you to change the season, feast, or festival
associated with the chosen date. By default, if there is a feast or festival available
for that date, it will be selected. If, however, you would prefer to celebrate the normal
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seasonal week instead of the feast or festival, you may do that by clicking the drop-
down box and selecting an alternative. If the selected service is for a special occasion,
such as a wedding or funeral, you will also select that information here, under
Other Occasions and Services.

Second, you may change the title of the service. All new services are automati-
cally titled with the day of the Church Year falling on that date. If, however, you
would like to use custom titles (for instance, if you are planning a thematic series 
of services), you can change that here. The service name will change to reflect your
entry.

Last, you may select the times at which you will be using this service. All
available service times for the selected date and Location will be filled in for you
automatically. If you would prefer to create the service for some times and not others,
you may uncheck those times you do not want. If you are creating a special service
or changing the time of a service, you may add another service time with the Add
button. A service will be saved for all selected service times.

Once you have created a service, and you are satisfied with the locations, times,
and other configuration options available to you at this step, the next part of the
process is to select an order of service.

Outlining an Order of Service

Figure 3.2. The order of service selection process.
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Now that we know the time of our service and its Location, we can move on to
define what the service will look like. The order of service you choose will estab-
lish your service outline. To this outline, you will then be able to add and remove
service elements, choose specific content for those elements, add custom content
for elements you would like to change, and select from a host of other features
intended to give you more control over your service-building.

When you first move to the outline step, you will be presented with a list of the
built-in orders of service available to you. These will be separated by source mater-
ial, and then by type, so you can easily find the materials you wish to use. Selecting
an order of service from this list and using it “as-is” is the most basic way to pro-
ceed (as was covered in the tutorial above), but let’s look at the depth of options
available to you here.

There are four basic lists available for your use in the Task Pane. At the top,
the service you are currently editing is shown, along with its liturgical color and the
name of the week, festival, or feast associated with that date. Each panel is selected
by use of a link. As you select each list, it will expand to fill the Task Pane.

The first, and default one, is the list of orders of service. To use one of these
orders, simply click on it and its associated outline will appear to the right in the
Work Pane. Once you have selected it and the outline is displayed, you may alter
portions of the service to fit your needs.

For example, to move an element earlier or later in the service, simply click,
hold, and drag the element to the intended new position. Black guide arrows will
appear as you move the element up or down, to indicate to you where in the service
the selected element will be placed. Drop the element into place when the arrows
indicate it is where you want it to be.

If you’ve already made some changes to another service, and you’d rather not
repeat that process, or if you have a service that is the same on a yearly basis, you
can start from an outline you were working on for a previous occasion. Click the
link marked Copy an existing service at the bottom of the Task Pane. A new area
will open up—here, you can select a month and year from your service history, and
Lutheran Service Builder will display all the services associated with that given
time period. Simply click on one of the listed dates to bring its service flow over to
your new service. You can then proceed to edit the flow of the service, just like you
would if you had created a new one from the previous menu.

Moving elements around is wonderful. But what if we would like to add a few
things of our own or even take part of the service out to make room for something
else we’d like to do? Fortunately, adding and removing elements to our service is a
very easy task and doesn’t take much work to do. Click on the link at the bottom of
the Task Pane labeled Add service elements. A list of the available elements will
appear in the Task Pane. To add an element to your service, simply drag it over to
the outline and drop it into place, just like you would move an element already in
the service. Elements added to a service in this way are empty and have no content
by default. You will have to add that content when you move on to the next step.
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To remove elements from your service, click on them in the outline. Once 
they are highlighted, click the Delete button on the right-hand side of the outline.
The element will be neatly excised from the outline. Should you accidentally delete
something you wanted to keep, just click the Undo button, and your changes will
be reset.

If you’d rather have a different title for a given element in your service, simply
highlight that element by clicking on it in the outline, and then click the Rename
button in the upper right. You’ll be able to type in a new name for that element.

The last option you have for editing the outline of your services is to add a rite
to your service. This is different from adding elements, in that an element is a single
addition to your service, whereas a rite is basically a second outline that you add 
to an existing service. It will have multiple elements already, and those elements
will likely be filled with content. Some examples of rites would be Holy Baptism,
Imposition of Ashes, or Holy Matrimony. To add a rite, work with it the same way
you would an element: simply drag and drop the rite into your service. A new section
will appear; you may then edit it as you see fit.

Once you have the building blocks of your service in place and ready to go,
then you need to flesh them out fully by selecting content. Right now, your service
is made up of multiple headings and very little content. When you move to the next
step, however, Lutheran Service Builder will begin to add content to your service,
including text, music, and readings. In the next section, we’ll learn how to adjust
those elements, change their content, or choose from the options given to you by
Lutheran Service Builder.

Choosing Service Content

Figure 3.3. The content selection step in service creation.
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A hymn inserted into your service without a page number or a title isn’t really
a hymn: it’s simply a placeholder for what you’ll be adding to the service to make it
complete. The same thing goes for any service element you’ve decided to use. Until
you’ve selected what type of content you’d like to use for that part of the service, it
will either remain a text element (as is the case with many of the default elements),
or it will simply display the title of the element and nothing else.

In order to get the content you want into the Service, you will have to tell
Lutheran Service Builder what content you’re looking for, and how you want to
display it. This section will be divided by the types of information you can present
using the Builder and how to alter those elements using easy-to-use options and
visual reinforcement.

When you move to this step of the process, the complete outline for your service
will be displayed in the Task Pane. You’ll be able to see at a glance all the elements
you have selected and the content you have used to fill those elements. Elements
that are pre-filled with content will display only the title of that element. Elements
that are pre-filled with content from a fluid source (such as the Lectionary) or that
have multiple pre-defined content options will be displayed with a filled check box.
Elements that require you to select content and to fill them will be displayed with
an empty check box. You may click on any of these elements to access available
options. Please note that some elements are limited to titles only and may not be
selected in any other way (e.g., Offering).

Static Elements
A static element is one that is created for you automatically by Lutheran Service

Builder. Many elements in a given service will fall under this category; the vast
majority of elements in the Divine Services or Daily Offices will be static elements.

A good example of the options available to you when using a static element is
the Kyrie from Divine Service, Setting Three. When you first select the element,
you are presented with a few basic options:

These options will be standard as you continue to edit elements within your
service. The three main options from which you may choose reflect the appearance
of the selected element. They are Title, Text, and Melody. When you choose your
desired option for the currently selected element, its appearance in the Work Pane
will change to show you the end result. Title displays only the name of the element,
and a hymnal page number if applicable. Text displays only the text of the element,
with proper responsorial icons and text styled to assist reading. Melody will display,
if available, the melody line for that element, along with its associated text.

You may select different options for different portions of your service. For
example, you could select to display the Kyrie as melody, but display the Gloria
Patri as only text. To change the option selected by default, use the Service Format
tab in the Preferences dialogue.

Depending on the element you are editing, and what options are available,
other options may appear at the top of the Work Pane. They are:

• Show me hymns that can replace this [name of element]. Often, you will find
that you may like the structure of a given order, but would prefer to substitute
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other music for liturgical elements. Lutheran Service Builder recognizes elements
of particular types that lend themselves to being replaced by hymns with a 
similar theme or purpose, and will allow you to substitute whatever hymn you
please. Upon clicking this link, you will be presented with the hymn selection
dialogue, which will be covered in more detail later.

• I would like to use the [name of element] from another liturgy. Lutheran
Service Builder knows which elements in each given order are related to one
another. For instance, the Kyrie in Setting One and the Kyrie in Setting Four
are different in musical form, but are alike in text and in content. Should you
wish to “borrow” an element from an order of service other than the one you
are currently using, you can click this link. You will then be prompted to select
the appropriate service element.

• I would like to write my own [name of element]. Selecting this option will
open up the Text Editor, which will allow you to compose a custom version 
of a given element for that particular service. This is very handy if you are 
in the middle of planning a service and decide that you would like to include
an element that is not part of the standard order of service you have selected. 
The Text Editor used here is similar to using the My Worship Resources
option on the main menu of Lutheran Service Builder, and as such will be 
covered in more detail in Chapter 5.

Fluid Elements
Fluid elements are those elements that are usually pre-filled with content by

Lutheran Service Builder, but whose content may differ from service to service.
These elements are usually limited to two main categories: propers and readings,
where both types of elements are controlled by the currently selected liturgical date
and the Lectionary from which you are working at a given Location, and any portion
of an order of service that has multiple options for display. A prime example of the
second type would be the Confession and Absolution found in any given setting of
the Divine Service, where you have more than one form of that element you could
choose to display. We’ll cover both types in detail.

For all types listed here, you will also (as with static elements) be presented
with the options of Title, Text, or Melody. Those selections work exactly the same
as they do with static elements, so you already know how to work with them. Let’s
focus on what’s different.

Propers, whose contents are controlled by the Lectionary, will automatically be
filled with the appointed content. This content will appear in the Task Pane outline
as a filled check box, followed by the name of the selected content. Click on the
element to select it and display its content in the Work Pane. In some cases, more
than one option will be available for a given occasion or service. In this case, you will
be presented with a set of options at the top of the Work Pane. Choose whichever
option best fits a given service, and Lutheran Service Builder will automatically
retrieve that data and present it to you as part of the service.

Readings are also selected by the Lectionary data associated with your chosen
Location, but added customization for them is available. For instance, when you
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select a reading by clicking on it in the outline view, you will be presented with the
options available for the currently selected liturgical date. Lutheran Service Book
has multiple options for some dates, and those options will be presented here. Some
are longer or shorter versions of the same reading, while others are choices between
two completely different texts.

Readings, however, have yet another option: you may select a custom reading
for a given service. To do so, simply enter the full Scripture citation you wish to
use in the field provided. Once Lutheran Service Builder recognizes the citation 
as valid, it will automatically pull the chosen reading from the included English
Standard Version text and place it into the service. Using this feature, you may
have as many or as few readings in a service as you want, and you can change them
to fit any given situation. The possibilities for customized services are endless.

Elements with liturgical choices are fluid elements. As noted above, we’ll use
Confession and Absolution as an example, since it is the fluid element you will
most often encounter in practice. When you select an element with choices, you’ll
be presented with an option box just like the one for the readings. These options
correspond directly to the columns presented to you in a print copy of Lutheran
Service Book. For example, in the Confession and Absolution element, you have
the choice of a full Absolution or the Declaration of Grace. Whichever you select
will be the only one exported into your finished service. Another example would be
sections of a service that have different texts for Advent or Lent.

Empty Elements
Some elements will begin with no filled content whatsoever; these elements

will require you to select appropriate content and then will insert that content into
the service for you. An empty element has an empty check box under its title. To
select an empty element, click on it in the outline.

Elements you have added to the currently selected service during the Outline
step will always be empty elements and will require you to fill in their content. In
those cases, you will be asked to select content as if you had simply used the corre-
sponding pre-filled or fluid element. For example, if you add a reading, you will be
presented with the same selection screen in the Work Pane, but it will default to a
custom-created element. Complete it by entering a Scripture citation in the provided
blank.

For the most part, you will be dealing with empty elements in the form of
hymns. Orders of service that include hymns will almost always default them to
empty. Hymns you add to a given service will always be empty by default as well.
When you select a hymn in the Task Pane, the Hymn Selector will appear in the
Work Pane.

The Hymn Selector is easy to use, and a very powerful tool in assisting you in
selecting appropriate and thematically related hymns for your service. When you
first select a hymn, Lutheran Service Builder will present for you a list of suggested
hymns for the given liturgical date. This is to aid you both in finding appropriate
hymns and in using a liturgical event to use some hymns you might not otherwise
encounter.
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If you choose not to use the suggestions provided for
you, you have two main options for finding an appropriate
hymn. The first, and most powerful of these options is to
use the included Hymn Search. Click Search for hymns at
the bottom of the Hymn list. You will be presented with the
following options:

As you select which options you would like to use to
search for your desired hymn, boxes will open into which
you should type your search criteria. For each option, let’s
take a look at what kind of information you would use and
what kind of results you can expect. When you have entered
your search query, click the Search button at the bottom of
the Work Pane to be shown your results.

A word or phrase in the Hymn looks up exactly that.
You can search for any part, no matter how small or large,
and the search engine will find that phrase in every possible
hymn. If you would like to search for all occurrences of a
word, simply type it in and press Enter. If you put in more
than one word separated by spaces, the engine will find all
occurrences of either word and display those accordingly. 
If you would like to search for a phrase, enclose it in quotes
(e.g., “evil foe”) and the search will return only those hymns
that contain that phrase.

You may also search using Scripture
on which the hymn is based. By typing
in one or more Scripture citations (press-
ing the Enter key between each reference),
you can find specific hymns related to a
specific passage of Scripture. This is use-
ful if you are trying to choose a Hymn of
the Day to match your sermon text, or if
you are looking to match readings or an
overall theme. You may also have
Lutheran Service Builder automatically
search for hymns based on the readings
already selected for a given service.

Hymns in Lutheran Service Book are
arranged topically. To narrow your search
to a specific topical focus, choose one of
the divisions from The hymn(s) category
or topic drop-down menu. Lutheran
Service Builder will display all hymns
associated with that topical heading.

Figure 3.4. 
The search criteria 
for a hymn.

Figure 3.5. 
Searching using topical 
or seasonal divisions.
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Another option is to search either by meter or by tune. To do so, select one
using their respective drop-down menus, and click Search. This can be very useful
if you have a hymn text you would like to set to a different tune, or vice versa.

You may also search by author or composer’s name. The search engine will
check the information stored for each hymn to find any occurrences of that name 
in text, tunes, or settings (though settings are not available in the Builder itself).

In the case of custom worship resources, you may also search by the name of
the user who entered the hymn into the database. For instance, if you know your
music director placed hymn text into the My Worship Resources editor, and you
would like to retrieve it but do not know its name or associated information, you
may select his or her name from this drop-down box and be presented with all the
hymns he or she has entered into the Builder.

Keep in mind also that you are not limited to using one of these search criteria
at a time. You may use any or all of them to further narrow your search for the right
hymn for a given situation. Once you have some experience with the search functions
of Lutheran Service Builder, you will be able to easily and quickly find the hymns
you want to use, and it will become an indispensable tool in your weekly worship
preparation.

More about Hymns and Their Options
Hymns deserve more attention regarding how they can be displayed and what

kinds of options are available to you regarding their display, content, and insertion
into a service. A great deal of the power of Lutheran Service Builder is based on
how it handles hymns and its powerful management of these resources.

When you have completed a search for a particular hymn (or if you choose to
simply browse all hymns), you will be presented with a list of the results generated
by Lutheran Service Builder. You may sort this list in one of three different ways,
all marked by the icons at the top of the search results. The first is to sort the results
alphabetically by first lines, the second, to sort by hymn number (which also sorts
topically), and the third option sorts search results by relevance to your search
terms. To select a hymn for inclusion
in the service, click on its title in the
search results.

Upon selecting a hymn, it will be
previewed to the right of the search
results in the Work Pane. The title of
the selected hymn will be displayed at
top. The content of the hymn defaults
to your preferred setting in the
Preferences dialogue box. For any
given hymn, you may choose to display
and print the title and number of the
hymn, the text of the hymn by stanza, or the melody of the hymn with text by line. 
The displayed material will change as you select your preferred output.

Figure 3.6. 
The icons for sorting search results.
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To select stanzas to be included for a given hymn, click the Change stanzas...
button at the bottom of the display. You will be presented with a dialogue box—
unchecking a stanza will remove it from the hymn, and vice versa. Click OK to
commit your changes to the selected hymn. Texts will display only chosen stanzas
sequentially by original stanza number. A hymn melody will display any of the first
four stanzas under the melody line, while the rest of the stanzas will be printed
beneath the hymn as text elements.

You may also sample the melody of most hymns by clicking the play button 
at the bottom of the display. A built-in MIDI file will play the melody line for you.
To stop playback, simply click the stop button to the right.

The hymns in Lutheran Service Builder also have a great deal of additional
indexing information and cross-referencing tools available for your use. With a hymn
selected, click on the Info button in the top right-hand corner. You will be presented
with author and composer information, copyright information (useful if you are
obtaining permission to use these elements separately from LSBHymnLicense.NET),
tune details, usage history, topical assignment, and detailed scripture references for
each stanza. You may click on any blue text to display relevant information.

You may search and cross-reference any hymn in the database by tune, meter,
of Scripture reference in a given stanza. For most people, this will be more infor-
mation than they truly need in order to plan a worship service, but how much or
how little you use these tools is completely up to you.

Obtaining Copyright Permissions
The next major step in planning a service is to ensure that you are reproducing

your service materials in accordance with copyright law. We touched on this briefly
in the tutorial section of this manual. To reiterate, in order to reproduce copyrighted
worship materials, either within Lutheran Service Book or from other worship
resources entered into the Builder using My Worship Resources, you must obtain
copyright permission from the copyright holders of those texts and tunes. Worship
materials available to congregations today exist in part because they are protected
by copyright regulations. Part of creating and exporting a service using Lutheran
Service Builder is to obtain those permissions responsibly, and enter the appropriate
information into the Builder, so the necessary copyright notices can be added to
your bulletin output. Lutheran Service Builder will help you with this process with
friendly and intuitive prompts and information requests.

About Copyright Permissions
A significant percentage of liturgical elements and hymnody included in a 

worship service are protected by copyright law. Copyrights provide the means by
which individuals who create such resources are paid for their time and work. You
must get permission from a copyright holder before printing or making copies of
copyrighted material, including a service prepared with Lutheran Service Builder.
This permission can be acquired in several ways. You can ask the copyright holder
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directly for permission to use a given resource (though this typically must be done
at regular intervals or even every time you use the copyrighted material), or you can
obtain a license agreement that administers payments to individual copyright holders
out of a pool of annual licensing fees. In either case, you will be required to pay 
both for the right to use such materials (whether on an individual use basis or by 
a subscription-style license fee) and to report your usage to the appropriate group:
either the holder or the administrator of your license agreement.

How you obtain these permissions is completely up to you and your congregation.
Some congregations prefer to obtain permissions on a case-by-case basis, while others
will find the licensing model attractive because of its ease-of-use and simplified pay-
ment structure. In either case, be sure to have the name of your license or copyright
holders handy when entering your copyright permissions into the related step of 
the Builder process, as well as your assigned license numbers; these will be needed
to print the required copyright notice and licensing identification number on your
finished bulletin.

About LSBHymnLicense.NET
To ease this process, and to provide users with the ultimate option for easy

copyright management and reporting, Concordia Publishing House also offers a
copyright licensing structure called LSBHymnLicense.NET. This structure provides
annual reprint and reuse permissions for nearly every hymn provided as part of
Lutheran Service Book and Lutheran Service Builder. Your copyright permissions
and payments are handled by Concordia Publishing House as part of your annual
fee for being licensed in LSBHymnLicense.NET. This fee is priced based on your
average worship attendance to ensure proper compliance to copyright restrictions
and proper reporting of true usage of copyrighted materials. To purchase a sub-
scription to LSBHymnLicense.NET, please consult Appendix C: Obtaining
Support or contact a Concordia Publishing House customer service representative.

Once you have purchased an LSBHymnLicense.NET subscription, you must
enter your license number into the Preferences tab labeled Electronic Licenses.
Type in the license number you were given at the time of purchase and click the
OK button. From this point on, LSBHymnLicense.NET will track your usage of
copyrighted materials, speed you through the rest of the copyright permissions
process, and report your usages automatically to Concordia Publishing House 
(provided you have a working Internet connection). Remember, regardless of 
the frequency with which you use any combination of hymns, you pay only one
convenient fee per year.

You are required by agreement to report your usage data at least once every 
30 days. If you have not reported your data, the program will gently remind you 
on a regular basis until you have completed the reporting process.
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The Copyright Permissions Step
If you are using a large number of public-domain hymns or have purchased the

built-in LSBHymnLicense.NET from Concordia Publishing House, you will rarely
have the need to secure permissions for the use of copyrighted materials; every-
thing you need to do will be done for you by default. However, there are a few
hymns not covered by the agreement, and since not everyone who uses Lutheran
Service Builder will be using LSBHymnLicense.NET (even though it is the easiest
and least painful path through this process), there’s one last area we need to cover:
the manual entry of copyright permissions.

You will be presented the following screen when you move to the Copyright
Permissions step of service preparation:

Figure 3.7. The Copyright Permissions step main window.

In the Task Pane is a representation of your current service outline. Every ele-
ment in your currently selected service is presented here, just like you’ve seen in
the previous steps. If you have no materials requiring further copyright permissions,
then you will be told with a notice at the top of the Task Pane, and you may click
through to the next step using the Project Bar.

If, however, there are materials used in your service requiring you to state your
copyright permissions, they will be highlighted in bold typeface in the service outline.
To select an item, click on it in the outline view.

You’ll be presented with a list of permissions required before you can legally
use the resource in question. For each resource, there are three options presented.
The first is to indicate that you do not have permission to use the stated resource. 
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If this is the case, you will not be permitted to continue the service creation process
and export your service. You must go back and choose another resource for which
you have reprint permission to continue.

The second is to inform Lutheran Service Builder that you already have a
licensing agreement that covers multiple types of materials or materials from a
broad selection of publishers. Examples of these kinds of licenses include
OneLicense.net and CCLI, among others. If you are using these license agreements,
it is your responsibility to ensure that the materials you are using are indeed cov-
ered by your license agreement (as with LSBHymnLicense.NET, there may be some
portions of your service that are not). To indicate your usage in this way, click the
appropriate option. You will then be required to type in the name of the license you
are using, as well as the license number assigned to your congregation. This infor-
mation will be printed in your service to satisfy copyright notification; however,
unlike with LSBHymnLicense.NET, you will be responsible for reporting your
usage to the appropriate license administrator. Check with your licensing company
for more information on how to report your usage information.
LSBHymnLicense.NET is the most convenient approach to copyright management
in Lutheran Service Builder.

The third option is to obtain permission to use the resource from the actual
copyright holder. This process can be more costly than a license agreement, and it
also can be more frustrating. Some hymns have multiple copyright holders; a few
provided in Lutheran Service Book have three or more separate copyright holders
for a single hymn! For each hymn, Lutheran Service Builder compares your selected
stanzas and retrieves copyright information for each. For each element requiring
permission, information will be displayed about the copyright holder and will include
contact information for the office responsible for administering that copyright. It 
is your legal responsibility to obtain permission to use these materials before you
export them for congregational use. Lutheran Service Builder will present to you
contact information for each copyright holder appearing in this step to assist you in
this process.

As you enter your permissions information into Lutheran Service Builder, each
successive hymn will be de-bolded. Once every hymn in your service requiring 
permissions has had its information completed, you will be permitted to access the
final step in the service creation process. Click the green arrow at the right of the
Project Bar to move on to the final step.

Exporting Services for Use
The final step in preparing your service is to take that service and then make it

usable for worship. In Lutheran Service Builder, this is the export feature. You can
export to a file, edit the service further, and then print that service, or you may choose to
have Lutheran Service Builder create PowerPoint slides for projection during worship.

This is also the step in the process where you will apply style sheets to your
completed service, by choosing typefaces, font weights and sizes, colors, and
effects for your text. By doing so, you can customize the look of your bulletin to
match the preferences of your congregation.
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Upon exporting your service to one or more file formats, your usage of copy-
righted materials will be noted and (if you are using LSBHymnLicense.NET) those
statistics will be added to your copyright usage reports for transmission to Concordia
Publishing House. For this reason, you should not export a service until you are 
satisfied with its content and layout. Previews of every element in your service are
available in the planning steps of the process; if you would like to see what your ser-
vice elements will look like on the printed page, you should go back to those steps.

Both the direct printing option and the PowerPoint export option provide pre-
views before committing to an export action, so you can be sure of what you will
see in the final product.

What Do I Need to Export My Services?
In order for service exporting to function correctly, you must have an active

annual support subscription with Concordia Publishing House. Lutheran Service
Builder will contact CPH via the Internet at regular intervals to determine if this
subscription exists. If you are unable to connect to the Internet for this communica-
tion to occur, you will be prompted to contact CPH to obtain an unlock code that
will allow you to continue exporting services with Lutheran Service Builder.
Without proof of an active subscription to the Annual Support and Liturgy License,
Lutheran Service Builder will deactivate all export-related functions until it can
verify that you hold an active subscription with Concordia Publishing House, 
either via the Internet or by codes obtained over the phone.

As part of this support contract, you will receive technical support via phone,
product updates of both data (supplied automatically over the Internet) and program
features (delivered through installer downloads), as well as the CPH Liturgy License,
which allows for annual reprinting of all copyrighted liturgical materials contained
within Lutheran Service Builder.

The cost of your first year of this subscription is included in your initial purchase.
Concordia Publishing House will automate your billing on an annual basis. Current
subscription rates are provided on the Lutheran Service Builder Web site at
lsb.cph.org.

As long as Lutheran Service Builder is able to determine that you have an active
support subscription, and that you have submitted your copyright usage reports to
Concordia Publishing House (if you are subscribing to LSBHymnLicense.NET), 
you will be able to export your services and use them for congregational worship.
Should Lutheran Service Builder disable your export features, and you know your
subscription is paid and active, please contact CPH support for further assistance.
In the unlikely event that your annual subscription should cease, Lutheran Service
Builder: Congregational Edition will revert to the search-only Lutheran Service
Builder: Home Edition.

Exporting to a Lutheran Service Builder File
One of the strengths of Lutheran Service Builder is that it has the ability to

save a service to a special type of file that can then be transferred onto a different
computer and edited there. This is very useful for situations where one or more of
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the computers on which you will be using Lutheran Service Builder is not connected
to your other computers via network. For instance, you could start creating a service
on your office computer, export that service to a Lutheran Service Builder file, and
then e-mail or transfer that service to your secretary for polishing and printing. The
secretary would be able to open the file, view all your selected options, and then
output those options to a file.

About Seat Licenses
Remember that each computer on which you have installed Lutheran
Service Builder counts as a “seat license” as defined in your purchase
agreement and in the End-User License Agreement.

For example, if you install a copy of Lutheran Service Builder to your
office computer, and a copy on your laptop or home computer, those instal-
lations use up the two seat licenses included with a purchase of the Builder
by a small congregation. Larger congregations receive more seat licenses,
but also pay higher licensing fees. The same applies for two computers in
the same physical location. One copy on the music director’s computer,
one copy on the pastor’s computer, and one copy on the secretary’s com-
puter requires three seat licenses.

Additional seat licenses beyond your purchase agreement are available
from Concordia Publishing House.

In order to export your service in progress to a Lutheran Service Builder file,
go to the final step in the service creation process. You will be presented with three
choices.

Use the first: Export
the service to a file. You
will be presented with a
Save As dialogue; select 
a save location for your
exported service and assign 
a filename to it by typing 
it in the box at the bottom.
Click Save to finish your
export of the file.

That’s it!

Figure 3.8. 
The three choices in the final step of service preparation.
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Controlling the Look of Your Services
In order to export your services to a printable file, simply click on the Make a

bulletin for this service link in the final step of the creation process. You’ll be pre-
sented with some basic choices you need to make before you’re ready to reproduce
this service for use.

Not all congregations are created alike. Different people have different prefer-
ences, and it’s likely that you have developed a style and a look for your service
folder that caters to the needs of your congregation, one that is familiar and expected.
Thankfully, Lutheran Service Builder has an easy-to-use and universal way to alter
the look and feel of your service exports to fit your congregation’s style.

First, select the size of paper on which you would like to export or print your
services. This will determine your final page layout. The selected paper size for the
current service will be displayed at the top of the Task Pane. This default can be
changed by using the Locations tab in the Preferences dialogue. If you wish to
change the paper size, click on (change) and you will be presented with a dialogue
with print options. Several pre-formatted options are available in the drop-down
menu at the top of the Work Pane. If you would prefer to set a custom paper size
and/or custom margins, simply alter the appropriate fields in the Work Pane. Your
changes will be saved automatically.

The next option is the most powerful layout option available in Lutheran
Service Builder: the application of style sheets. It presents a slightly more compli-
cated, but hopefully still familiar interface for selecting your typefaces, font
weights and sizes, and alignment preferences. The Task Pane will display your 
currently selected style sheet (you can create your own style sheets and save them
under you own names in the future). Three style sheets are included with Lutheran
Service Builder as a demonstration of its capabilities: Default, Classic, and Deco.

There is also a simple check box for creating a Large Print version of your 
service bulletin. A Large Print version of your service will change all elements to
text-only, and will increase the text size to accommodate visually impaired members
of your congregation.

If you would like to edit the available style sheets, click the (change) link next
to the style selector to bring up the style sheet editor.
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Figure 3.9. The style sheet editor.

At the top of the editor, you may choose from any of the pre-defined style
sheets, or you may choose to save a style sheet you have altered as a different style
sheet with a new name (in which case you may retrieve that style sheet later using
the drop-down menu at left). Select any style and it will appear in the preview 
window.

To edit a style, you first select which portion of the style you would like to
change. To do so, you may either click on the element in the preview window, or
select the element from the drop-down above. Doing so will highlight the element
in the preview window, and also alter the settings below to match the currently
selected options for that element in that style sheet.

Once you have selected an element, you may then adjust the options below as
you wish. Font color, font face, size, and textual effects may all be assigned as you
see fit to any given element in the style sheet. You may also select the alignment of
your chosen element, its indentation relative to the margin, and line spacing using
the controls at the bottom. As you make changes, they will be reflected in the sample
element displayed in the preview window above. Your changes will be saved to the
service automatically.

Once you are satisfied with your style sheet application, you may save it for
future use by clicking the Save As button at the top of the Work Pane. Type a name
for your new style sheet in the dialogue box that appears, and click the Add button
to permanently add your custom style sheet to the list of pre-defined ones.

Once you are satisfied with the look and feel of your service bulletin, it’s time
to export that service to a file or to print it.
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Exporting to RTF
Rich Text Format (RTF) is a universal file format that can be read by most

word processors. We recommend exporting to RTF if you are going to edit your
service in any word processing program other than Microsoft Word. RTF will 
preserve your text formatting, the vast majority of your layout options, and will
allow you to edit your layout using your word processor. To export a file to Rich
Text Format, click on the appropriate save icon at the bottom of the Task Pane.

You will be presented with a save dialogue, asking you to select a save location
and a file name for the service you have just created. Type in your filename, select
your save location, and click the Save button to export your file. You’re done! Now
you can open that file using whatever word processing program you normally use,
complete your edits and layout, and print your completed service!

Exporting to Microsoft Word
Lutheran Service Builder can also export service bulletin files as .doc files,

which are compatible with Microsoft Word. If you primarily use Microsoft Word,
we recommend saving in this format, as more of your selected layout, style, and
options will be preserved and you will likely have to perform less polishing to 
complete the look of a service before printing. These files can be opened and edited
on any computer with an installed copy of Microsoft Word. To export a file to this
format, click on the appropriate save icon at the bottom of the Task Pane.

You will be presented with a save dialogue, asking you to select a save loca-
tion and a file name for the service you have just created.  Type in your filename,
select your save location, and click the Save button to export your file. You’re
done! Now you can use Microsoft Word to open the service, edit your layout and
formatting, polish your text, and prepare your service for printing and use!

Exporting to HTML
The services you design are constructed internally in Lutheran Service Builder

as HTML (Hypertext Markup Language) files. It is possible for you to output these
files directly. The most common use for this export file format is to post your com-
pleted services to a Web site; typical uses for this type of distribution are for students
or other members who are out of town but would like to listen or watch your service
over the Internet, or shut-in members who would like to do the same. These files
can be opened and edited by the majority of word processors, but they are very 
difficult to work with when editing layout and adjusting other such options. As a
result, we recommend using HTML output only when you plan on posting a bulletin
to a Web site, and not for general office use. To export a file to this format, click on
the appropriate save icon at the bottom of the Task Pane.

You will be presented with a save dialogue, asking you to select a save loca-
tion and a file name for the service you have just created. Type in your filename,
select your save location, and click the Save button to export your file. That’s it!
Lutheran Service Builder will output an HTML file and a folder containing the
images used in the service.
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Exporting to Microsoft PowerPoint
Exporting to PowerPoint is a slightly different process from the other methods

previously discussed. It involves a couple of additional steps, and looks slightly dif-
ferent than printing to a file type, but this is because Lutheran Service Builder gives
you more control over outputting to PowerPoint than you need to print a service.

When you move to the final step, you won’t be creating a bulletin as you have
been for the printable output. Instead, click on the PowerPoint slide logo next to 
the option Create a PowerPoint presentation for this service. Lutheran Service
Builder will go through the process of creating the basic slides (you’ll see a
progress bar here), and you’ll be presented with the PowerPoint creation step. 
It looks like this:

Figure 3.10. The PowerPoint creation step, showing the outline in the Task Pane, and
the slide creation tool in the Work Pane.

This step won’t look completely unfamiliar. You’ll be presented with the ser-
vice outline in the Task Pane, just like you’ve seen in previous steps of the process.
All your chosen elements will be there and ready for you to view. The slide style
editor looks much like the style sheet editor used in the text export process.

You won’t be able to edit the slides directly using this interface; for that, you
can open up PowerPoint and use it to alter the final look of your service. What you
can do to your service is change the master slide for the presentation, as well as the
slide backgrounds and settings you would like to use for each section of the service.
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Lutheran Service Builder comes preinstalled with three slide backgrounds that
are designed to match the look and feel of the Lutheran Service Book project and
associated materials. You are free to use these backgrounds as you wish, or you
may create your own. Above the outline view in the Task Pane, you select the master
slide background you would like to use for your entire presentation. This back-
ground will then be applied to every slide in your service.

If you would like to create a new slide style, find a portion of the service for
which you would like to use that style. Select it by clicking on its heading. The first
slide will appear at the top of the Work Pane. You may then begin the creation of
your new style by clicking the Save New... button at the bottom of the Work Pane.
You will be asked for a name for your new style; name it something descriptive to
make it easier for you to remember the style.

This will activate the controls at the bottom of the Work Pane for setting the
look and feel of the slide. You can set a background for the slide by clicking the
Browse... button. This will bring up a file dialogue; simply navigate to the image
file you would like to use for the background and click OK. You can use any com-
monly used image file type. Lutheran Service Builder will scale your image to fit
the slide.

You may also alter the appearance of the text by switching the font size and
style, changing the text alignment, or by adding effects (such as bold or underline)
or color. These changes will be reflected as you make them on the sample slide at
the top of the Work Pane. When you are satisfied with your edits, click the Save
button at the bottom of the Work Pane to make Lutheran Service Builder remember
your settings.

To assign a slide style to a section of your service, simply change it with the
drop-down menu at the top of the Work Pane, next to the slide preview. Doing so
will change every slide in the current element to the new style. Other elements in
the service will be unchanged. To change the slide style for every slide in the service,
use the drop-down at the top of the Task Pane. This will set the master slide for all
slides.

Once you have altered settings to your liking, click the button at the bottom of
the page labeled Create PowerPoint presentation. Lutheran Service Builder will
launch Microsoft PowerPoint on your computer, and create the presentation. From
there, you may edit the slides however you wish using PowerPoint. At this point,
please note that your presentation has not yet been saved; use the Save command
from within PowerPoint to save your presentation to disk.

You may add or remove slides to the presentation, edit existing slides, change
transitions or effects, and alter your presentation in any other way you desire.
Lutheran Service Builder provides the framework for a fully-functional, ready-to-
use PowerPoint worship presentation!
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Chapter 4. Using the Worship
Resource Search

Lutheran Service Builder’s utility is not limited to bulletin creation alone.
Because it uses a large database of interconnected information, and has that infor-
mation available at all times, it is also able to search worship elements (even elements
you have added to the program!) for specific information. For instance, say a
parishioner walks into your office and can’t remember more than a few words in the
text of a hymn, and you’d like to help them remember. You can easily find this hymn
and perform many more functions by using the search capabilities integrated into
Lutheran Service Builder.

To start, at the main What would you like to do? menu, select the option
labeled Find a single worship resource. You’ll be taken to the search screen. You
can select the type of search you would like to run by using the links provided for
you in the Task Pane, and your search results will be displayed in the Work Pane.

Let’s take a look at the different categories of searches you can perform, and
what kind of options they present.

Searching Hymns
Searching hymns using this feature of Lutheran Service Builder works exactly

the same as searching hymns while you are creating a service and editing its content.
You are presented with a selection of criteria by which you may search the hymn
database. Click the check box next to a search type to select it; it will then expand
to display an entry field.

As you select which options you would like to use to search for your desired
hymn, boxes will open into which you should type your search criteria. For each
option, let’s take a look at what kind of information you would use and what kind
of results you can expect. When you have entered your search query, click the
Search button at the bottom of the Work Pane to be shown your results.

A word or phrase in the hymn looks up exactly that. You can search for any
part, no matter how small or large, and the search engine will find that phrase in
every possible hymn. If you would like to search for all occurrences of a word, sim-
ply type it in and hit Enter. If you put in more than one word separated by spaces,
the engine will find all occurrences of either word and display those accordingly. 
If you would like to search for a phrase, enclose it in quotes (e.g., “evil foe”) and
the search will return only those hymns that contain that phrase.

You may also search using Scripture on which the hymn is based. By typing
in one or more Scripture citations (pressing the Enter key between each reference),
you can find specific hymns related to a specific passage of Scripture. This is useful
if you are trying to choose a Hymn of the Day to match your sermon text, or if you
are looking to match readings or an overall theme. 
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Hymns in Lutheran Service Book are arranged topically. To narrow your
search to a specific topical focus, choose one of the divisions from The hymn(s)
category or topic drop-down menu. Lutheran Service Builder will display all
hymns associated with that topical heading.

Another option is to search either by meter or by tune. To do so, select one
using their respective drop-down menus, and click Search. This can be very useful
if you have a hymn text you would like to set to a different tune, or vice versa.

You may also search by author or composer’s name. Partial entries in this
field are acceptable; the search engine will check the information stored for each
hymn to find any occurrences of that name in text, tunes, or settings (though set-
tings are not available in the Builder itself).

In the case of custom worship resources, you may also search by the name of
the user who entered the hymn into the database. For instance, if you know your
music director placed hymn text into the My Worship Resources editor, and you
would like to retrieve it but do not know its name or associated information, you
may select his or her name from this drop-down box and be presented with all the
hymns he or she has entered into the Builder.

Keep in mind also that you are not limited to using one of these search criteria
at a time. You may use any or all of them to further narrow your search for the right
hymn for a given situation.

As before, you may choose to organize your results either alphabetically by first
line, in ascending numerical order (which is also topical in nature), or by search 
relevance to your selected criteria.

When presented with your search results, click on the title of a hymn to select it.
The selected hymn will be displayed in the Work Pane. You have several options
for displaying your search results as well as working with those search results. 
As with the previous searches, you can choose to view the text or tune of the hymn,
or to view the reference information available for that hymn. You may also select
which stanzas you would like to view, and access the audio MIDI file preview of
each hymn.

The hymn search function also provides one-click printing and copying of
hymn texts and melodies as long as you have a current subscription to the Annual
Support and Liturgy License. The buttons to the right of the hymn preview provide
these functions. Click on the printer button to send the currently previewed material
to your default printer, or click on the copy button to copy those contents to the
Clipboard; you may then move that information into other applications or documents.
Printing or copying hymn information in this manner requires permission from the
copyright holder(s) of that material.
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Searching Pericopes
Lutheran Service Builder comes pre-loaded with full pericopes from the Three-

Year and One-Year Series. Every reading for every seasonal service, as well as
feasts, festivals, and occasions is stored in the database and is fully searchable.

Figure 4.1. Searching for a pericope occurrence in the Church Year.

To find a specific reading, simply type in a scriptural citation in the provided
blank. As you type, your results will be shown in the window below. Searches can
be as detailed or as broad as you would like. For instance, you could search for any
occurrence of anything from a single book, a chapter, or even a specific verse. You
will be presented with results: the complete reading as presented in the Lectionary
is cited, as well as the day of the Church Year to which the reading is linked and in
which Lectionary that occurrence appears.

You can click on any reading citation to display the corresponding text from
the English Standard Version, and you can also click on the stated day of the
Church Year to display the complete propers and pericopes assigned to it.

If you’d like, there is also one-click access to a hymn search based on your given
scriptural citation. Simply click on the Show me hymns based on this pericope
link under the search field. You will be taken to the hymn search screen, and your
search will run automatically.
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Searching Propers
The propers included with Lutheran Service Builder may be searched by key

words and phrases. This search function operates much the same as the hymn
search function. You’ll be presented with a search field; type in the text you would
like to search for.

Figure 4.2. Searching for a proper.

Using the drop-down menu below, select the type of proper you would like to
find. You can search for any portion of the regular propers you wish, or all of them
at the same time.

Lutheran Service Builder will search its database for all occurrences of the
search criteria you have specified. It will return a list of the propers found, the type
of propers they represent, and their representation in the calendar of the Church
Year. You may click on each proper to view its complete text, or click on the day 
in the Church Year to view the complete propers for that date.

Searching Collects
Lutheran Service Builder provides access

to a large number of prepared collects for
weekly prayer and services. You may search
these collects and preview their information
using the Builder. This can be a great help 
to you for finding a collect appropriate to a
particular occasion, date, or service theme.

To search for a collect, click the appropri-
ate link in the Task Pane. The search criteria
blanks will appear in the Task Pane. Type in the keywords for which you would like
to search and, if appropriate, select a topical grouping of collects to further narrow
your search. Once you have provided your search criteria, click the Search button.

Lutheran Service Builder will run your search through its database of collects
and return for you a list of their headings to the right in the Work Pane. To preview
a collect, click on its heading. The full text of the collect will appear to the far right.
You may copy this text to the Clipboard for inclusion into other documents.

Figure 4.3. 
Searching for a word in the Collects.
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Searching Scripture
You may also use Lutheran Service Builder to search the complete text of the

English Standard Version of the Bible for a word or phrase. Type the word or
phrase you would like to find in the blanks provided (the search box will search 
for an exact match of the words you have provided), and click the Search button.
The left-most bottom window will display your search results, along with a total
count of references found.

Figure 4.4. The Scripture search.

To view a result, click on it. The text in question will appear to the right. If you
would like, you can also use the controls below to use that same search result in a
hymn or pericope search, just as if you had used the other search functions. This
makes searching for a hymn based on a Scripture passage you don’t fully recall
very easy to do—simply search for the words you remember, select the citation,
and conduct a related search!
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Chapter 5. Managing Custom
Worship Resources

There may be times when your congregation will have need of a special service,
a hymn text not included in Lutheran Service Book, or a specific service element
you would like to insert for a special occasion or event. Perhaps you are in need 
of a portion of your service to recognize a service anniversary or to commission a
specified ministry, and you can’t find an element to fill out of any of the materials
included in Lutheran Service Book. For these instances, we have created My
Worship Resources.

My Worship Resources is an intuitive, easy-to-use, and powerful editing suite
that allows you to create, store, and later recall service elements you have edited.
You can organize your elements as you wish, providing easy ways to retrieve them
at a later time for use as you see fit in your services. This provides an excellent
option for extending the power and usability of Lutheran Service Builder. You
could always create these service elements after you have completed a service and
exported it to your word processor, but with My Worship Resources, you are then
able to use those elements just like the other elements within the Builder’s search
engine.

Custom worship resources behave much like any of the resources in Lutheran
Service Builder. They can be placed and moved at will in your service outlines, 
and they follow your style sheet design rules to achieve a uniform look with the 
rest of the service, but they are also easily created, changed, and saved for later use.
My Worship Resources puts in your hands the same basic tools used in the creation
of the standard information included with Lutheran Service Builder. Using the export
tools included with Lutheran Service Builder, you also have the ability to export
your custom elements and resources, and share those elements with other users of
Lutheran Service Builder.

How do custom worship elements work with 
copyright permissions?
When you create a custom worship element, you are given the opportunity
to provide a copyright notice for each portion of that element. If you pro-
vide such information, you will be prompted to provide your permission
information during the Copyright Permissions step of the service-building
process, just as if you had used material from Lutheran Service Book.

You must provide copyright information for each hymn you enter into My
Worship Resources.
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The custom resources you can create are separated into three main categories:
hymns, elements, and collects. To open My Worship Resources, click on the
Add/Edit My own worship resources button on the main What would you like 
to do? menu. You will be presented with four clickable choices in the Task Pane.
These choices correspond to the types of resources you may create. Continue reading
to learn more about each.

My Hymns
Click on the My Hymns link to be presented with the main hymn selection

window. The Task Pane will fill with a list of your categories and hymns, ready for
preview and selection. You may search these custom hymns by using the blank at
the top of the display.

To add a hymn, first add a topical category to the collection. You can do so by
using the New button at the bottom of the display. Select Category from the menu
that appears. A new category will appear in bold in the selection area; type a name
for this category and hit the Enter key when you are done.

Once you have created a category for your custom hymns, it’s time to add one.
Click on the New button at the bottom of the Task Pane and select the Hymn...
option from the menu that appears. The New Hymn Wizard will appear to guide
you. Perform the following steps to complete your hymn and add it to the database:

1. Enter the title of your new hymn. Click Next.

2. Now, you need to enter the stanzas and text associated with that hymn. For each
stanza, click the New button to add it to the master list to the left. Once you have
it in place, you may edit its content using the blank at the right. Hymn content 
is treated as text only. Once you are finished, click New again to add another.
Use the Remove button to delete the selected stanza if you make a mistake.
Click Next once you are satisfied that the entire hymn has been entered correctly.

3. At this step, you can provide music to accompany your hymn if you wish. Music
must be in a graphical format Lutheran Service Builder can read—TIFF, BMP
or PNG file formats. We recommend a scan at 300 dpi. Lutheran Service Builder
best distinguishes text from music in high-contrast (1 bit per pixel or strict black-
and-white). You may add melody, setting, or both. Click on the link for the
desired addition, and Lutheran Service Builder will ask you where the graphics
file is located.

PERMISSION MUST BE OBTAINED FROM THE COPYRIGHT
HOLDER(S) OF ALL MATERIALS IMPORTED INTO LUTHERAN
SERVICE BUILDER FOR EACH USAGE. FAILURE TO DO SO 
IS A VIOLATION OF FEDERAL COPYRIGHT LAW.

4. For each imported music scan, Lutheran Service Builder will “slice” the music
to separate music from text. This is how Lutheran Service Builder knows to print
the stanzas you specify when selecting the hymn as a service element. Check the
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slices to make sure they are correct. Hover your mouse cursor over each section;
music slices will turn green, while text slices will turn blue. Double-click a slice
to switch it from one type to the other. Click and drag the blue slice lines to
adjust the sizes of the slices to prevent text or music from being “clipped” in the
wrong places. Hold ALT while dragging a slice line to create a new one.

Once you are satisfied that Lutheran Service Builder has correctly sliced your
graphic, click Next to move to the next step.

5. Now, you have to tell Lutheran Service Builder which lines of text in your
graphic file belong to which stanzas you specified at the beginning of this
process. Click on the lines of text to the left to highlight them in blue. You may
hold the CTRL key to select multiple lines of text, or you may hold the ALT key
to select every line of text in the same position in each line (i.e., all first-stanza
lines, all second-stanza lines). Once you have selected the proper lines of text,
click on a stanza in the window to the upper-right. This links the selected graphical
lines to the stanza of the hymn. When you have finished this process for each
stanza, click Next.

It is okay if you have text stanzas that have no assigned graphical lines. They
will be printed as text as you have entered them.

6. If you would like to include both a melody line and a setting, select the one you
have not yet entered and repeat the process. If you are finished entering music,
click Next.

7. Now it’s time to populate the custom database with all the great information
Lutheran Service Builder uses to cross-reference and search your hymns. If you
designed your hymn to function in place of a standard liturgical element, select
that element using the drop-down box to the upper-left.

Assign musical criteria to your hymn. Select the tune name associated with that
hymn from the drop-down in the lower-left. If the tune you are using is not rep-
resented, use the Edit Tunes... button to create a new one. Select the key of the
hymn from its respective drop-down element, and if you have a MIDI file of the
melody, you may import it into Lutheran Service Builder using the Browse...
button below.

Now you need to fill in the cross-referencing information Lutheran Service
Builder needs to categorize your hymn and relate it to others in the database.
Enter topical headings for your hymn, one per line, in the blank provided. 
Refer to the topical headings in Lutheran Service Book if you would like to 
place your hymn within those topics.

Finally, you may assign Scripture references to each stanza as well. Select the
stanza in the drop-down box provided, and enter one Scripture citation per line
in the box below.

When you are done, click Next.

8. The last step is to enter the copyright information for your custom element. This
information will be used to present you with the copyright holders’ names and
information when you are finishing your service content. Be absolutely certain
you are entering accurate information.
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When you have completed this task, click Finish to add the hymn to your list.
Your hymn will appear as part of the category you had selected at the beginning
of the process. It may be further edited or used in services you create from this
point forward.

If you make a mistake entering text or would like to remove a category or
hymn, use the Delete button at the bottom of the Task Pane. You will be asked 
to confirm your deletion of the selected element. Be careful when editing your
custom resources—deletion is permanent!

My Elements

To create a new element you can insert and use in any service you create in
Lutheran Service Builder, use the My Elements link in the Task Pane.  You will
see a list of the elements you have already created.  To add a new element to your
collection, use the New button at the bottom of the Task Pane.  You may use this
button to either create a new category into which you can place completed elements,
or to begin creating a new element from scratch.

A New Element will be created.  Type a name for your new element and press
Enter to confirm your choice.

In the Work Pane are several groupings of controls that help you to create these
elements.  The most obvious of these—and the one you will use the most—is the
text entry area at the bottom of the Work Pane.  Here, you will type the text you wish
to use in your custom element.

At the top of the Work Pane are two fields into which you may enter information
regarding the copyright holders of the material.  If you are creating the element,
you may choose to enter yourself as a copyright holder.  You may then assign 
specific copyrights to this information by using the box and controls on the right.
This information will be used by Lutheran Service Builder when you or others 
integrate these elements into services.

Between these sets of controls is a row of buttons used to format the text you
enter as a custom element.  At the very left are a pair of buttons with curved arrows;
these buttons control the Undo and Redo functions of the text editor.  Next are
Bold and Italics controls, which will either work as you type or will affect currently
selected text.

Next to the right is a pair of buttons and a drop-down menu.  These controls
affect the responsorial icons you often see at the left margin of elements included
with Lutheran Service Builder or used in Lutheran Service Book. To use this feature,
select the text you wish to separate with an icon.  Select the appropriate icon from
the drop-down menu and click the button with the filled icon.  Your text will be
indented and a responsorial icon of the chosen type placed in front of it.  This will
apply only to the selected text, but it also must apply to entire paragraphs.
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For example, if you have selected only a partial section of a paragraph (which
is defined by line breaks in a section of text), the entire paragraph will end up within
the responsorial group.  This can also serve as a way to speed up the transformation
of text into responses, as simply placing the entry cursor within a paragraph and
clicking the icon button will transform the entire paragraph into a response.

To remove a previously formatted section, select it as you would when you
created it, and click the button with the empty responsorial icon.  The text will be
converted to normally formatted text.

The next set of buttons allows you to create block-indented sections of text.
Clicking one either Indents or Unindents a paragraph, one level per click.

Two more controls are at the far right of the button bar.  The one marked with
the cross symbol used in Lutheran Service Book will insert that icon wherever the
insertion cursor is currently located in the text entry box when clicked.

The final control allows you to import music to be used for your custom element.
Upon clicking this button, you will be presented with a file dialogue.  Find a graphics
file of an appropriate type, and click the Open button.  Your music will be automat-
ically “sliced” and will appear in the text entry area at bottom.

Created custom elements are saved as you create them, and may be used imme-
diately in a created service.

My Collects

Creating a collect is a much simpler task than creating an element.  These collects
are designed to be integrated into larger elements or as a Collect element in a service
outline.  These collects are created in plain text.  Just as you would do with a custom
element, use the New button at the bottom to create a new collect.

Now, give your collect a name.  Once you have confirmed the title of your collect,
use the text entry fields in the Work Pane to create the content of your custom collect.
Assign a topic to the collect using the drop-down menu.  (This helps to integrate
your collects with those included with Lutheran Service Builder.)

Next, enter the text of the collect itself.  There are two separate text entry fields
given here.  Lutheran Service Builder allows users to choose between using a short
termination and a long termination.  If you wish to use both, you must enter text for
each in the blanks provided.

Lutheran Service Builder will save your collects as you edit them.  There is no
need to click any kind of save button or menu command as you work, and completed
collects are available immediately for incorporation into created services.
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My Tunes

Adding a custom tune is useful for matching custom elements to one another if,
for instance, you are using one element and would like to see if you have other
compatible elements available with which to mix-and-match content.  Lutheran
Service Builder comes with a complete database of every tune included with
Lutheran Service Book. Once you add your own tunes to this database, you can use
them to cross-reference your resources with those used in Lutheran Service Book.

To add a new tune, use the New button at the bottom of the Task Pane.  Give
your tune a name, then begin by filling in the information requested in the Work
Pane.  Assign a name to your tune, and fill in its meter (used for searches for com-
patible tunes with another given element).  Give the tune author and copyright
holder information.

Images cannot be assigned to a tune, but must be assigned to a hymn element
instead.

Lutheran Service Builder will automatically save your tune information as you
enter it.  Created tunes can be used immediately in creating new hymns as well.
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Chapter 6. Upgrading Lutheran
Service Builder

Over the product life of Lutheran Service Builder, updates will be provided 
by Concordia Publishing House as needs arise: to solve issues with the software,
improve performance, add features, or include more information or materials in the
resource databases.

For regular product updates, registered users of Lutheran Service Builder will
be notified via e-mail. Updates will be posted to the Lutheran Service Book Web
site at lsb.cph.org and made available for download. These updates will fix any
common problems that may be experienced by users, as well as upgrade the func-
tionality of Lutheran Service Builder at regular intervals.

Updates to Lutheran Service Builder will be released as new features and fixes
to existing functions are released.  These patches will be provided through an auto-
matic update utility included with your installation.  The updater runs once each time
you start Lutheran Service Builder, and will only notify you if there are changes
available.  If you are using a dial-up or otherwise intermittent Internet connection,
you may also use the Check for Updates… command in the Tools menu to force
Lutheran Service Builder to connect to the CPH server and request any program
updates that are available.

If a program patch or update is available, you will be prompted by Lutheran
Service Builder to begin downloading it.  You may postpone the download of updates
if you do not wish to install them at the time they are available.  Once the appropriate
files or content have been downloaded to your computer, Lutheran Service Builder
will install them automatically and prompt you to restart the application.

The data included with Lutheran Service Builder will also be updated on a reg-
ular basis. If your computer is connected to the Internet, Lutheran Service Builder
will check for these updates automatically on a regular basis. To check for updates
manually, you may use the Check for Updates option in the Tools menu of
Lutheran Service Builder. Your copy of Lutheran Service Builder will contact
Concordia Publishing House to retrieve the latest information available. You must
have an active Annual Support and Liturgy License subscription to use this feature.

These database updates will be applied to your installation automatically.
There will be no installer to run or any other process to manage. A status bar will
appear to inform you of the progress of the update. Do not quit Lutheran Service
Builder or turn off your computer or Internet connection while this update is
running! Doing so could cause damage to your database files!

To view a list of the changes made from one update to another, check the
Lutheran Service Book Web site for the latest version of this manual. The effects 
of the latest updates are always listed at the end of the document for easy access.
Any changes made to Lutheran Service Builder will also be reflected in the online
version of this manual.
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For major revisions of Lutheran Service Builder, new CD-ROM releases may
be made available for purchase. These revisions will be subject to a one-time
upgrade fee, but will carry the added benefit of significant feature additions and
changes to the program not easily added by use of downloadable installers. Major
revisions of this type will be announced well in advance of release through e-mail
and through the Lutheran Service Book Web site at lsb.cph.org.

Appendix A. User Preferences
When you want to change the way Lutheran Service Builder behaves, you may

alter your default settings, add and remove service times, or do anything to shape
Lutheran Service Builder to better fit your congregation’s needs. These choices and
settings are made using the Preferences window. What follows is a set of screen
shots of these window tabs, as well as brief explanations of some of the limited
options available to you in each screen.

When you install and run Lutheran Service Builder for the first time, you are
essentially going through each tab of the Preferences window, one by one, so
you’ve actually already been here, even if you don’t realize it. And, for most people
and congregations, that first run-through is going to be enough to keep you going as
long as you’re using Lutheran Service Builder.

If you’d like to change some settings, however, you most certainly can.
Remember that changes will affect only new services created from this point 
forward; older services will not change without direct input from you. Our tour 
is broken down by tabs, which are located at the top of the window. Click on each
one to view and alter its settings.

The General Tab
The General tab

hosts most of the
options that don’t
affect your Locations
or content. These
options will affect your
experience with the
program, how things
look to you, and what
information you would
like presented on a reg-
ular basis.

Figure A.1. 
The General tab of the
Preferences dialogue.
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The General tab includes settings that will affect background activity and
some of the built-in assistance functions. Show tooltips on the Taskbar enables
the little “pop-up” descriptions that appear when you hold your mouse cursor over
the buttons in the Project Bar. Check for updates on startup allows Lutheran
Service Builder to use your Internet connection to contact Concordia Publishing
House’s servers to check for updated files or product upgrades. Clean up tempo-
rary files and compact databases on quit will cause Lutheran Service Builder to
take longer to close down when you are finished with it, but will save hard disk
space by removing unnecessary data from your computer when you are finished.

The Performance option allows you to control how Lutheran Service Builder
uses your computer’s available resources. You can choose to allow the Builder to
consume more of your computer’s active memory to speed up your search results.
If you have the recommended system specifications detailed at the beginning of this
document, feel free to keep the enhanced performance enabled. If your system is
older or has specifications closer to the minimum, you will find better performance
by conserving your memory. Otherwise, Lutheran Service Builder may cause your
computer to become unresponsive.

The Hymns grouping controls some of the preview display and tracking options
for your hymnal databases. The main control is the selector to determine the length
of time over which you would like to display statistics for hymn selections. Lutheran
Service Builder tracks your usage of hymns so you can view their frequency of use by
using the Info feature. The amount of time displayed is adjusted via this drop-down
menu.

The Locations Tab
The Locations tab gives you one-stop access to the data you have stored in your

user profile for all defined Locations. Much of this information was created for you
during the Setup Wizard, using controls very similar to those found here in the
Preferences dialogue.

Figure A.2. 
The Locations tab of the

Preferences dialogue.

At the top of the
dialogue, you can select
the Locations you have
saved to Lutheran
Service Builder. The
Add and Remove but-
tons to the right allow
you to add or subtract
Locations from this list.
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Deleting a Location from this list will also delete any services attached to it!
Think twice before you change these settings if you have services in the
database you plan on reusing or referencing!

When you have a Location highlighted, you can press the F2 key to rename it
if you wish.

Selecting a Location activates the controls at the bottom of the window. From
here, you can change the default Lectionary to be used with the given Location,
modify the bracket for weekly worship attendance (required to comply with licens-
ing and copyright agreements), revise your default export and PowerPoint layouts,
and amend the stylesheets for controlling the default look of your services.

The Service Times Tab
The Service Times tab lets you view, edit, and delete the times and frequencies

of your services at each Location. For each type of service you can select a default
liturgy as well.

Figure A.3. 
The Service Times tab
of the Preferences 
dialogue.

At the top of the
window, select the
Location for which
you would like to
alter these settings. 
If you have only one
Location, it will be
selected by default.

To add or remove a weekly service time, use the buttons to the right of the list of
your existing times. To the right, you can use the drop-down menu to select a default
order of service for your weekly worship. The order you select here will be automati-
cally applied to all new weekly services generated from this point forward. It can be
changed in any service, and it does not need to be set to a specific service at all.

When you have finished with any changes, make sure you click the OK button
to save them.
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The Service Format Tab
The Service Format tab stores your preferences for the default display of worship

elements.

Figure A.4.  The Service Format tab of the Preferences dialogue.

Select a Location in the drop-down menu at the top of the window. If you have
only one Location, it will be selected by default. These settings can be different for
each Location you have created.

For each type of element, either hymns or liturgy, select the default view you
would prefer in your final materials. This choice can be changed on an individual
element basis, but when a service is initially created, all new elements will follow
these choices.

When you are finished with your changes, click the OK button to save them.
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The Electronic Licenses Tab
The Electronic Licenses tab allows you to submit or print your hymn usage

reports for Concordia Publishing House, or to add non-LSBHymnLicense.NET
licensing information to your installation of Lutheran Service Builder. This is useful
in cases where you already subscribe to a copyrights licensing program that covers
some of the material presented in Lutheran Service Book, and do not wish to use
LSBHymnLicense.NET.

Figure A.5.  The Electronic Licenses tab of the Preferences dialogue.

The left-hand side of the dialogue tab allows you to change settings related to
LSBHymnLicense.NET. If you would like your usage reports to be automatically
transmitted to Concordia Publishing House without your interaction, check the box
marked Send reports without asking me. To manually send a report, click the
Send Report… button.  If you do not have an Internet connection, but still need 
to submit a usage report to comply with the terms of the license, click the Print
report… button to send a pre-formatted usage statement to your default printer.
This usage statement can then be mailed to Concordia Publishing House in order 
to fulfill your hymn license usage agreement.

License numbers, usage totals, and permissions are handled for you automatically
for all elements from copyright holders participating in the LSBHymnLicense.NET
program.  Usage of items for which you were required to obtain permission sepa-
rately is not included in this report, including any information imported into My
Worship Resources.  This report tracks usage statistics only and is exclusively for
the purpose of generating royalty payments to appropriate copyright holders.
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If you choose not to subscribe to LSBHymnLicense.NET, but would like some
assistance in the Copyrights and Permissions step of the service creation process,
you may store your licensing information within Lutheran Service Builder here.
Click the Add button to create a new entry.  To fill it, simply select it in the list,
then type the name of the license (e.g., CCLI, OneLicense.NET), and your license
number (assigned by the licensing entity).  You will then be able to recall this infor-
mation as part of the Copyrights and Permissions step to quickly enter your licensing
information as needed.

Note that you are still responsible to report your usage to the appropriate
licensing agreement! Lutheran Service Builder neither collects nor submits usage
information for any licensing structure other than LSBHymnLicense.NET!

What about other types of electronic licenses?
If you are a subscriber to an electronic license other than LSBHymnLicense
.NET, you will have to report your usage independently of the automatic
controls provided with Lutheran Service Builder. You will be responsible
for tracking your usage and sending those reports to the appropriate license
administrators.
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Appendix B. Additional Resources

In preparing your services for corporate worship, we hope that you will find
Lutheran Service Book and Lutheran Service Builder to be indispensable tools and
constant companions. We also expect that you will run across situations where you
will need to supplement Lutheran Service Book with additional content.
With that in mind, consult the resources below:

lsb.cph.org—The official Lutheran Service Book Web site. Here, you will find
updates and corrections to Lutheran Service Builder. New content will be
added as the attendant volumes of Lutheran Service Book are integrated into
the Lutheran Service Builder databases.

lsbhymnlicense.net— Do you have questions about licensing the use of 
copyrighted materials or about the license agreements included with Lutheran
Service Builder? For more information on these and other questions regarding
copyrights, manual reporting helps, and additional tools to help you get more
out of the resources of Lutheran Service Book, visit the official site of
LSBHymnLicense.NET.

music.cph.org—Home to a vast catalog of materials and resources for the 
worship life of your congregation. Looking for a choral setting of a hymn to
augment the theme of your service? Check with Concordia Publishing House’s
music department for ideas and materials faithful to the Scriptures and the
Lutheran Confessions.

worship.lcms.org—The home page of The Lutheran Church—Missouri
Synod’s Commission on Worship, developers of Lutheran Service Book.

www.cph.org—The home page of Concordia Publishing House, publisher and
distributor of Lutheran Service Book, Lutheran Service Builder, and many
more products for both church and home that are faithful to the Scriptures and
the Lutheran Confessions.
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Appendix C. Obtaining Support

If you run into problems installing, running, or using Lutheran Service Builder,
or have a question concerning how to use your copy of Lutheran Service Builder,
we at Concordia Publishing House understand that you’ll need support to help with
your issue. There are several ways you can obtain this support.

First, you should check with both the built-in Help system (by going to Help➞➞

Help...) and the printed manual included with your Lutheran Service Builder purchase.
The answers to many of your questions, especially those concerning the routine use
of Lutheran Service Builder, can easily be found there.

Second, check with the Lutheran Service Book Web site at lsb.cph.org. Under
the “Support” section of the site, you will find several resources that will help you.
Frequently Asked Questions give you an insight into what other users of the program
are asking and immediate answers to those questions. Product updates will also be
available on the site; always check to make sure you are using the latest version of
Lutheran Service Builder before contacting support. An updated copy of this manu-
al will also be located on the Web site for you to access and check for any changes.
The online version of this manual will be updated continuously as the Builder is
updated and features are added.

If you are still unable to find an answer to your question or a solution to your
problem, please contact Concordia Technology Services at Concordia Publishing
House via phone or e-mail for support. In order to receive live support, you need to
have your CPH Customer Number handy. It is printed on the invoice you received
with your copy of Lutheran Service Builder, and also used as your serial number
during the installation process. You can also find your Customer Number using the
About... option in the Help menu. You also must have an active Annual Support
License subscription to Lutheran Service Builder to receive phone support.

Users of Lutheran Service Builder: Home Edition after 30 days from purchase
or those users of Lutheran Service Builder: Congregational Edition whose annual
support agreements have expired and have not been renewed will be charged for
support on a per-incident basis. Check with the Lutheran Service Book Web site for
current rates.

Contact Lutheran Service Builder support at (800) 346-6120.
We would be happy to answer any questions you might have or to troubleshoot

issues you are experiencing with Lutheran Service Builder.
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